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System Requirements
Software
Windows® 10, 8, 8.1, or 7 (32 and 64 bit)
Microsoft® Office 2010 or later
Internet Explorer 9.0 or later

Hardware
Processor: 1.8GHZ or faster
Memory: 8-16 GB RAM
Disk Space: 400MB available, SSD recommended

User
You must have Administrator or Power User privileges under Windows to
install a DownStream product. If you have Restricted User privileges you
may not be able to install the DownStream product. In this case, please
contact your network administrator.

About Installation
DownStream's installation program allows you to install the BluePrint-PCB
and CAM350 products (“DownStream products”), a license file and a
license manager. The license file and a license manager must be installed
to run the product.
License
Terms
License file

License
Manager

Definition
DownStream products require a license file to run. The license
file is named license.dat and defines the product, functionality
and number of licenses that can be run. You will receive a
license file from DownStream Technologies after you purchase
the product.
DownStream products require a license manager to run. The
license manager reads the license file and services requests to
run the DownStream product and to access specified
functionality. A license manager can be installed on your local
computer to service a single product client or on a network
server to manage requests of multiple product licenses from
several product clients.
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About DownStream Product Licenses
DownStream's licensing requires a license file and a license manager to
run the product. The licenses defined in the license file can be locked to
a hardware key, to a specific computer network adapter or shared on a
network.

License
Terms
Keyless
License file

License
Manager

Client
Computer
License
Server
Nodelocked
license
Networked
license
or
Floating
license
Virtual
Machine
Support

Definition
A DownStream product license which is locked to a network
adapter physical address as unique identification for licensing.
It does not require a hardware key (or "dongle").
DownStream products require a license file to run. The license
file is named license.dat and defines the product, functionality
and number of licenses that can be run. You will receive a
license file from DownStream Technologies after you purchase
the product.
DownStream products require a license manager to run. The
license manager reads the license file and services requests to
run the product and to access specified functionality. A license
manager can be installed on your local computer to service a
single product client or on a network server to manage requests
of multiple product licenses from several product clients.
The user computer(s) which the DownStream product is
installed and will run on.
The network computer which the DownStream license manager
is installed and runs on.
A DownStream product license which is locked to a specific
computer's network adapter physical address or hardware key
(“dongle”). The license can only be used to run the
DownStream product on a single computer.
A DownStream product license which allows a specified
number of product clients to run at the same time and on
multiple computers on your network. A license manager is used
to control the number of licenses that can be "checked out."
You may use any computer on your network as your "License
Server."

DownStream product licenses and license managers have
special settings that support Virtual Machine installations.
License files and the license manager have specific options that
support Virtual Machine installation.
3

Getting a License file
A license file is required to run DownStream products.

Purchase or Evaluation
1. The License file contains the Ethernet physical address for the computer
(license server) that will run the DownStream license manager. We will
need that information to create a license file for you. To get the Ethernet
physical address for the license server:
Go to the computer that will run the DownStream license manager
and type IPCONFIG /ALL from the Command Prompt window.
The Command Prompt window can be accessed from Microsoft
Window's Start - Programs - Accessories menu.
Look for Physical Address under Ethernet Adapter Local Area
Connection. The physical address will be represented by 12
hexadecimal numbers.
2. In most cases, DownStream Technologies requires this Ethernet physical
address information at the time of sale. E-mail this information to your
salesperson. In all other cases, or if you require further assistance, contact
us with the information:
Call us at 1-800-535-3226
Fax us at 1-508-481-0362
Email us at licenses@downstreamtech.com
Contact Technical Support at 1-508-970-0667 or
support@downstreamtech.com
3. You will receive an e-mail response with a license.dat file created for you.
Open the license file in a text editor and verify that the Ethernet physical
address corresponds to your license server and is correct. Use the
DownStream installation program to install the license file in the
appropriate directory for your license server.
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New Release while on Support
If we release a new version of your DownStream product and you are an
active support customer then we will include your new license file in the
installation media. When you run the DownStream install you will have the
option to install the license file from the installation media.

Updating License File for Existing Installation
If you get a license file update for either an expired license or support
renewal, we will include your new license file as an attachment in an email to
your company contact. Save the license file attachment to a local folder on
your computer. Run the DownStream install and select the Install License
File button. You will have the option to install the license file by browsing to
your saved license file.

Installing Products for a Single User Node-locked
License
If you have purchased a floating license (single user license that can be
shared) or a node-locked license (single user license that cannot be shared),
you should follow the instructions below to install a DownStream product:
1. Close all programs.
2. Choose one of the following:
If installing from an installable file on your hard drive (you have
downloaded the DownStream Installation executable from the
DownStream Website) then select and execute that file. Skip steps
3 and 4.
If installing from a CD, insert the DownStream CD into your CDROM drive. The installation starts automatically and you can skip
steps 3 and 4 when Autorun is enabled on your system.
3. If you do not have Autorun enabled, from the Start menu, select Run.
4. Type D:\setup (substitute the appropriate letter of your CD-ROM drive for
D).
5. DownStream Technologies Installation Wizard should now be running.
6. Accept the DownStream Technologies License Agreement and select
Next.
7. Select the Install License File button.
8. Enter Customer Information, select Destination Folder and select
Setup Type. Select Next to proceed from each dialog.
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9. Select the Browse to find License File option from the License File
Licensing Specification dialog and select Next. Browse to select the
DownStream License file. The DownStream Install wizard will read the
license file, recognize that it is a node-locked or floating license file and
install the license file (and license manager for floating) in the appropriate
directory.
NOTE: If you license is under support, the DownStream Install wizard will
recognize the license and automatically select Install from Media. The
DownStream Install wizard will then install you license from the installation
media and you do not need to browse to your license file.
10. Select Install.
11. Select Finish. You have installed your license file.
12. The Installation Wizard will now ask if you would like to install the
DownStream Products. Select YES.
13. Enter Customer Information,and select Setup Type. Select Next to
proceed from each dialog.
14. Select Install.
15. Select Finish. You have installed your DownStream products.
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Installing Products for a Multiple User Network License
About Multiple User Network Licenses
A DownStream Network License allows multiple users to run a DownStream
product simultaneously on multiple computers on your network. The license
file specifies the number of licenses and product functionality that can be
accessed and a license manager is used to service the license requests.
When a user runs a DownStream product, the product makes a request to
the license manager for a license. If the license is available then it is
"checked out" and the product can run. If a license is not available the license
request will fail and the product will not run. When the user exits the product
the license is "checked in" to the license manager and is available to be
requested by another product user. The computer that runs the license
manager is considered your "License Server". You may use any computer
on your network as your License Server. The computer that runs the
DownStream product in a network configuration is considered a "Client."
Note: Your network license is automatically updated by the DownStream
Installation Wizard. The SERVER and DAEMON lines are not correct until the
computer name and daemon file path are automatically updated by the
DownStream Installation Wizard.

Installing the License Manager: Network Server
A DownStream product requires a license manager to run with a floating or
network license. The license manager reads the license file and services
requests to run the DownStream product with specified functionality. A
license manager can be installed on your local PC to service a single product
client or on a network server to manage requests of multiple product licenses
from multiple product clients.
The computer that runs the license manager is the "License Server."
1. Run the DownStream Installation Wizard on the License Server computer.
2. Accept the DownStream Technologies License Agreement and select
Next.
3. Select the Install License File button.
4. Enter Customer Information, select Destination Folder and select
Setup Type. Select Next to proceed from each dialog.
5. Select the Browse to find License File option from the License File
Installation Option dialog and select Next. Browse to select the
DownStream Network License file.
6. Select Install.
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7. Select Finish. You have installed the License Manager and the Network
License file.
Note: The License Manager has been started after installation. The
License Manager will automatically start when the License Server host
machine is booted.
8. The Installation Wizard will now ask if you would like to install your
DownStream products. If the License Server computer will also be used
to run a product client then select YES and follow the instructions in the
topic "Installing a DownStream product on Multiple User Computers".
Otherwise, select No.

Installing Products on Multiple User Computers:
Network Clients
The computer that runs the DownStream product in a Network License
configuration is considered a "Client." If you are installing the DownStream
product on a Client computer in a Network License configuration then you
should follow the instructions below. Repeat these instructions for each Client
computer:
1. On the Client computer run the DownStream Installation Wizard.
2. Accept the DownStream Technologies License Agreement and select
Next.
3. Select the Install License File button.
4. Enter Customer Information, select Destination Folder and select
Setup Type. Select Next to proceed from each dialog.
5. Select the Set ACT_INC_LICENSE_FILE Environment Variable option
from the License File Licensing Specification dialog and select Next.
6. In the next dialog, enter the <port>@<computer name> for your License
Server (for example, “7102@FLEXLMSVR”). If you don't know your
License Server computer name you should contact your network
administrator. Select Next.
Note: The License Server computer name can be found on the License
Server computer by selecting Start - Control Panel - System Computer Name tab from Microsoft Windows.
7. Select Install.
8. Select Finish. You have installed your DownStream license environment
variable on the Client computer.
9. The Installation Wizard will now ask if you would like to install your
DownStream products. If the License Server computer will also be used
DownStream Technologies, LLC
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to run a product client then select YES.
10. Enter Customer Information, and select Setup Type. Select Next to
proceed from each dialog.
11. Select Install.
12. Select Finish. You have installed your DownStream products on the
Client computer
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Installing and Sharing a Single User Floating License
If you have purchased a floating license (single user license that can be
shared) you should follow the same instructions above to install a
DownStream product for s Single User Node-locked license.
A DownStream floating license is a single user license that can be shared
with any computer on your network. You can view your floating license as a
single user network license, where your computer can be setup as the
network license server for anyone you wish to share your license. When you
Install DownStream products for a Single User using a Floating License
you have already set up your computer as both a product Client and a
License Server. To allow another computer to share your Floating License
all you need to do is install the DownStream products on that Client computer
using your Floating License as the Client License and your computer name as
the License Server name.
Note: The floating license is a single license. When you are using your
DownStream product the license is "checked-out" by the license manager and
no one else can use that license. Conversely, if someone else has "checkedout" your floating license you cannot use it to run your DownStream product
until that user has exited the product and the license is "checked back in" to
the license manager.
To Share your Floating License:
The following instructions assume that you have already installed your
DownStream product and your Floating License on your computer using the
instructions for Installing DownStream products for a Single User: Nodelocked license.
1. On the Client computer run the DownStream Installation Wizard.
2. Accept the DownStream Technologies License Agreement and select
Next.
3. Select the Install License File button.
4. Enter Customer Information, select Destination Folder and select
Setup Type. Select Next to proceed from each dialog.
5. Select the Set ACT_INC_LICENSE_FILE Environment Variable option
from the License File Licensing Specification dialog and select Next.
6. In the next dialog, enter the <port>@<computer name> for your License
Server (for example, “7102@FLEXLMSVR”). If you don't know your
License Server computer name you should contact your network
administrator. Select Next.
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Note: The License Server computer name can be found on the License
Server computer by selecting Start - Control Panel - System Computer Name tab from Microsoft Windows.
7. Select Install.
8. Select Finish. You have installed your DownStream License environment
variable on the Client computer.
9. You can now install your DownStream products on your computer (which
is also the license server) or on the Client computer you just set up. Only
one of these computers can run the DownStream product at a time.
The Installation Wizard will now ask if you would like to install your
DownStream Products. Select YES to install the products.
10. Enter Customer Information and select Setup Type. Select Next to
proceed from each dialog.
11. Select Install.
12. Select Finish. You have installed your DownStream products on the
Client computer
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Custom Installation Options
If you have special installation requirements, the Custom Setup Type has
installation options that address specific needs. You are able to specify
installation context for all users, RSS feed preference, Allegro integration
preference, Working Directory, startup files for BluePrint-PCB and CAM350,
installed feature selection, and Installation Directory.

Installation Context
The Installation Context allows you to install DownStream Products using an
administrator login on the client PC machine and then have all other user logins
use the same customization information installed by the administrator installation.
The default is to install as an individual Per User installation (not administrator
installation).

Enable Live News Feed Updates
The Enable Live Feed option enables the RSS feed update on the DownStream
Product HTML start pages to download the latest product and corporate
information for an RSS feed on the DownStream web site. The default is
enabled for Live News Feed updates.

Enable DownStream Product Integration with Allegro
The Enable DownStream Product Allegro integration option enables automatic
integration binding with an existing Allegro PCB Design system for the installed
DownStream Products. BluePrint-PCB supports automatic creation and update
of BluePrint-PCB release packages. CAM350 supports cross probing with
Allegro PCB. The default is enabled for DownStream Product integration with
Allegro.

Working Directory
The Working Directory folder is the location where writable work files such as
sample and demo files are written for DownStream Product installation. The
default location is “C:\DownStreamTech\”. The installation folder for read only
binary files is described below.

Startup Files
Startup Files can optionally be specified for BluePrint-PCB and CAM350. The
BluePrint-PCB Profile file (*.BPP) is an exported file that contains all options that
are set in the Tools Options dialog in BluePrint-PCB. The BluePrint-PCB
DownStream Technologies, LLC
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Custom Menu file (*.BPS) an exported file that contains the Customization
settings for any user defined menus or toolbars. The CAM350 default CAM file
(CAM350.CAM) specifies the default *.CAM file used by CAM350 when a new
CAM350 file is created. The CAM350 Custom Menu file (*.settings) is an
exported file that contains the Customization settings for any user defined menus
or toolbars and also CAMNT95.ini file used to store preferences from the Setup
menu commands.

Features Installed
In the Custom Setup page, you can specify which DownStream Product features
to install. You can select to install BluePrint-PCB, CAM350 and/or DownStream
Support files. The default is to install all features.

Installation Directory
The Installation Folder defines where the read only files for DownStream
Products will be installed. The default location is dependent on the Windows OS.
For example, for Windows 10 64 bit, the default location is:
“C:\Program Files (x86)\DownStream Technologies\2016\ “
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License Borrowing
If you want to use a license on a computer that is intermittently connected to a
license server (for instance a laptop), that license can be borrowed from a license
server via a special checkout and used later to run a DownStream product on a
computer that is no longer connected to the license server.
With license borrowing, you specify the date when to return the borrowed license
and run the DownStream product while connected to the network which writes
borrowing information on the client computer. The license server keeps the
borrowed license checked out. The DownStream product automatically uses the
local borrowing data to do checkouts during the borrow period. Upon the
expiration of the borrow period, the local borrowing data no longer authorizes
checkouts and the license server returns the borrowed license to the pool of
available licenses.

Running the LicenseBorrow Utility from DownStream
LicenseBorrow is a DownStream Technologies utility and is installed in the folder
d:\DownStreamTech\LicenseManager.
To Borrow a License:
1.
2.
3.
4.
5.

Run LicenseBorrow on the client PC where you want to borrow licenses.
Enter the Borrow Expiration Date (dd-mmm-yyyy format)
Select the Set Borrow Expiration button
Start the DownStream product to borrow the license features.
You can now disconnect your computer from the network and use the
borrowed license to run the DownStream product.
6. Select the Don't Borrow Anymore Today button to prevent additional
features from being borrowed.
Checking Borrow Status:
1. Run LicenseBorrow on the client PC
2. Select the List Currently Borrowed Features button
The borrowing system does not have to be connected to the network to
determine the status.
Clearing the Borrow Period:
Once you have borrowed all the licenses that you need for the current borrow
period you can prevent licenses for any additional features from being borrowed
for the rest of that day.
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1. Run LicenseBorrow on the client PC where the license features were
borrowed
2. Select the Don't Borrow Anymore Today button
To Return Borrowed Licenses Early:
1. Stop all DownStream product sessions on the client PC where the license
features were borrowed
2. You can now connect the client PC to the network
3. Run LicenseBorrow on the client PC
4. Type the DownStream License File name or browse to the license file
5. Select the Return Borrowed Licenses Early button; all DownStream
Technologies borrowed licenses are returned
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Redundant License Servers
DownStream products allow customers to deploy redundant licensing
systems, enabling them to continue to run applications and check out their full
complement of licenses in the event of a prolonged server failure. When a
failed server is restored, operation continues as usual without interruptions. A
redundant server is physically three interconnected servers operating as one
logical server, dispensing from a master pool of licenses.
With three-server redundancy, if any two of the three license servers are up
and running (two out of three license servers is referred to as a quorum), the
system is functional and serves its total complement of licenses. If you wish
to use redundant servers, select stable systems as server machines; in other
words, do not pick systems that are frequently rebooted or shut down for one
reason or another. The machines that comprise a three-server redundant
configuration should:
• Run the same operating system
• Have excellent communications
• Reside on the same subnet
The three servers must be located physically close to each other. This form of
redundancy requires that the servers exchange heartbeats periodically, and
poor communications can cause poor performance. Avoid configuring
redundant servers with slow communications or dial-up links. Three-server
redundancy is designed to provide hardware fail-over protection only and
does not provide load-balancing.

About Redundant License Servers
Each of your license servers should set up and running in a redundant license
server setup. If you need help with your setup you should reference the
FLEXlm End Users Guide at www.flexerasoftware.com or contact technical
support at support@downstreamtech.com.

DownStream Technologies, LLC

Company Confidential
16 of 22

Virtual Machine Support
Virtual Machines are software applications that mimic a computer in both
performance and appearance while sharing physical resources like hard drives
and monitors on their host computers. Basically, a Virtual Machine (or VM) is an
operating system, running on top of a host computer with an operating system.
DownStream Technologies supports Virtual Machine licensing using the FLEXlm
tools from Flexera Software. DownStream supports network license servers for
virtual machines using unique host ID’s and special VM license daemons.
DownStream currently supports virtual machine suppliers: VMware and
Microsoft. The Virtual Machine host support includes the following platforms:
VMware ESX, VMware ESXi and Microsoft HyperV. The primary supported
HostID type for virtual machines is UUID (universally unique identifier). Use the
LMHOSTID utility provided by DownStream Technologies to get the UUID for
your virtual machine. See the download and usage instructions below.
If the UUID is not available for your virtual machine supplier, then the secondary
HostID type is available: USB dongle over IP (internet protocol). USB over
internet protocol products include AnywhereUSB™.
Ethernet (MAC) addresses are not supported by DownStream Technologies for
virtual machines.
If you have not already purchased Virtual Machine support, a license transfer to a
VM network license is required. The DownStream VM License Manager will be
provided upon completion of the license transfer. For existing licenses, a license
transfer is needed to switch to virtual machine licensing. Please download the
License Transfer Form for Virtual Servers. Then follow the instructions below
to obtain the UUID HostID, and send the completed transfer form to DownStream
per instructions at the following URL address.
NOTE: You must use the LMHOSTID executable provided by DownStream to get
your UUID.
http://www.downstreamtech.com/license-transfer-policy.php
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Silent Installation
Installation for products can be run silently by running the DownStream install
exe at a command prompt. There is a single command line argument for silent
installation. The command line argument specifies a text file with a set of
supporting Windows Installer properties that define how the client installation
should be executed.
The command line syntax for silent execution is as follows:
DownStream_<version>.exe /s /f1”<file_path>DST2016.iss”
/zDST_PROPFILE=<Win Installer Props File>

Files Required for Silent Installation
Three files are required to run silent installation. First, you need the DownStream
Installation EXE file. Second, you need a response file for the silent installation.
Third, you need a text file for properties passed to the installation wizard for the
silent installation.
1. DownStream Install EXE example: “DownStream_2016_c1132_b1232.exe”
2. ISS Response file: “DST2016.iss”
3. Properties File with Sample settings: “props_master.txt”
NOTE: The above Response File and sample Properties File are installed
with DownStream Products in the following folder:
C:\Program Files (x86)\DownStream Technologies\2016\Install_Documentation\

ISS Response File
The response file “DST2016.iss” is required for silent installation execution. A
working response file is installed in the default installation folder as described
above. NOTE: In the silent install command line, you must specify the absolute
file path for the DST2016.iss file or the results will be unpredictable.

DownStream Technologies, LLC

Company Confidential
18 of 22

Setting Up Your Silent Install Properties Text File
A text file (<Win Installer Props File>) that contains Windows Installer properties
is specified for the DST_PROPFILE command line argument. NOTE: In the silent
install command line, you must specify the absolute file path for the Windows
Installer properties file or the results will be unpredictable. The syntax for the
DST_PROPFILE text file content for supported Windows Installer properties is as
follows:
INSTALLDIR
=
<Installation Folder>
ADDLOCAL
=
<Product Features to Install>
DST_ALL_USERS
= <0 or 1>
DST_ENABLE_LIVE_WEB_NEW_FEEDS
= <0 or 1>
DST_ENABLE_ALLEGRO_INTEGRATION
= <0 or 1>
DOWNSTREAMTECH
= <Working Directory Folder>
DST_SRC_CAM350_MENU_FILE
= <CAM350 Custom Menu File>
DST_SRC_CAM350_CAM_FILE
= <CAM350 Default CAM File>
DST_SRC_BP_MENU_FILE
= <BluePrint Custom Menu File>
DST_SRC_BP_PROFILE_FILE
= <BluePrint Profile File>
DST_LIC_ENVIRONMENT_VAR
= <FlexLM ACT_INC_LICENCE_FILE Setting>

Where:
INSTALLDIR specifies where the binaries are installed for DownStream
products. The default location is “C:\Program Files\DownStream Technologies”.
ADDLOCAL specifies specific DownStream product features to install during
silent installation. The features are comma separated. If no ADDLOCAL
specification is present, then all DownStream product features are installed by
default.
To install BluePrint-PCB, specify the following ADDLOCAL argument:
DST_BP_CAM350,BluePrint,BluePrint_Application,BluePrint_Support_Files

To install CAM350, specify the following ADDLOCAL argument:
DST_BP_CAM350,CAM350,CAM350_Application,CAM350_Support_Files

To install DownStream support files, specify the following ADDLOCAL argument:
DST_BP_CAM350,CAM350,CAM350_Application,CAM350_Support_Files
DST_BP_CAM350,DownStream_Support_Files,Install_Documentation,
Sentinel_Driver_758,VCRedistributable
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DST_ALL_USERS specifies DownStream Products are installed using an
administrator login on the client PC machine and then have all other user logins
use the same customization information installed by the administrator installation.
DST_ENABLE_LIVE_WEB_NEW_FEEDS specifies whether the RSS feed
update is enabled for the DownStream Product HTML start pages. If enabled,
the latest product and corporate information is downloaded from the RSS feed on
the DownStream web site.
DST_ENABLE_ALLEGRO_INTEGRATION enables automatic integration
binding with an existing Allegro PCB Design system for the installed
DownStream Products.
DOWNSTREAMTECH specifies the Working Directory folder which is the
location where writable work files such as sample and demo files are written for
DownStream Product installations.
DST_SRC_CAM350_MENU_FILE specifies a custom menu file (*.camsettings)
that is exported from the “Customization…” command dialog in CAM350. This
customization file may include the CAMNT95.ini file also.
DST_SRC_CAM350_CAM_FILE specifies the CAM350 default CAM file
(CAM350.cam) that is loaded when CAM350 starts up. The contents are defined
when the command File > Setup > Save Defaults is executed.
DST_SRC_BP_MENU_FILE specifies a custom menu file (*.bps) that is exported
from the “Customization…” command dialog in BluePrint-PCB.
DST_SRC_BP_PROFILE_FILE specifies the BluePrint profile file (*.bpp) that is
exported from the Tools > Options > Environment > General dialog in
BluePrint-PCB.
DST_LIC_ENVIRONMENT_VAR specifies the value for FlexLM system
environment variable “ACT_INC_LICENSE_FILE” for the DownStream
Technologies FlexLM License Manager. This is appropriate for client
installations when accessing a floating network license server.
The following example of the DST_PROPFILE text file installs all DownStream
products in the default locations with default startup files. The license
environment variable points to the network license server.
DST_LIC_ENVIRONMENT_VAR=7102@FLEXLMLICSVR

DownStream Technologies, LLC

Company Confidential
20 of 22

The following example of the DST_PROPFILE text file installs only the CAM350
product for a client installation. Startup files are specified for a CAM350 custom
menu file and the default CAM350.cam file.
INSTALLDIR="C:\DownStreamTech2016\"
ADDLOCAL=DST_BP_CAM350,CAM350,CAM350_Application,CAM350_Support_Files
DST_SRC_CAM350_MENU_FILE="W:\DownStreamTech\CAM350 12.2\Demos\my.camsettings"
DST_SRC_CAM350_CAM_FILE="W:\DownStreamTech\CAM350 12.2\CAM350.cam"
DST_LIC_ENVIRONMENT_VAR=7102@FLEXLMLICSVR

The following example of the DST_PROPFILE text file installs only the BluePrintPCB product for a client installation. Startup files are specified for a BluePrintPCB custom menu file and a BluePrint-PCB profile file.
INSTALLDIR="C:\DownStreamTech2016\"
ADDLOCAL=DST_BP_CAM350,DownStream_Support_Files,Install_Documentation,
Sentinel_Driver_758,VCRedistributable
DST_SRC_BP_MENU_FILE="W:\DownStreamTech\BluePrint-PCB 5.2\BluePrint-PCB 52.bps"
DST_SRC_BP_PROFILE_FILE="W:\DownStreamTech\BluePrint-PCB 5.2\Profile 52.bpp"
DST_LIC_ENVIRONMENT_VAR="W:\DownStreamTech\LicenseManager\license.dat"

NOTE: The response file “DST2016.iss” is installed in the DST2016 installation
folder. The default location is:
C:\Program Files (x86)\DownStream Technologies\2016\Install_Documentation

NOTE: The properties file “props_master.txt” is installed in the DST2016
installation folder. This properties file contains various examples of properties
that can be included in your own properties file. To create your own properties
file, use a text editor and include only the Windows Installer properties that you
need to specify. The default location for “props_master.txt” is:
C:\Program Files (x86)\DownStream Technologies\2016\Install_Documentation

Sample Command Line for Silent Installation
The following is a sample command line for silent installation.
DownStream_2016_c1132_b1232.exe /s /f1"c:\DST2016.iss" /zDST_PROPFILE=c:\cam350_props.txt
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